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Welcome to Today’s Event

• Viewing tips & CPE credit information

• About the webcast sponsor, Tensoft

• Introduction to today’s speaker

• Presentation

• Q & A



Viewing Tips & CPE Credit

• For “Full Screen,” go to “View” on the Control Panel, g

• Submit questions any time using the “Question and 
Answer” pane

CPE certificates will be emailed to everyone who is • CPE certificates will be emailed to everyone who is 
eligible within  1 week

• Slides and webcast recording available on  
Tensoft’s Resource Center at www.tensoft.com



Introduction to Tensoft, Inc.



Who is Tensoft?

Tensoft, Inc.
> Business software solutions provider
> Focus on technology companies 
> S ft  f   t (RCM)> Software for revenue management (RCM)
Tensoft RCM Product Line
> Complete revenue management suite> Complete revenue management suite
> Business model transaction flow support
> Billing management for contractsg g
> Visibility, Productivity, Compliance
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Tensoft RCM – Revenue 
Managementg
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Tensoft RCM - Revenue Management

Sales Transaction
• Generated based on Go To Market Model• Generated based on Go-To-Market Model
• Generated from website, ERP, Tensoft RCM Contract
Revenue BasisRevenue Basis
• Determination of policy for document type
• Revenue base determination

• Sales Transaction Based
• SOP 97.2 based – residual method
• EITF 08-01 based – relative value method

• Revenue rules, sub-ledger, and analysis
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Introduction to 
Werner Consulting Group



Werner Consulting Group

Jeffrey WernerJeffrey Werner
Werner Consulting Group
Revenue Recognition Consulting 
Since 2001Since 2001

Background
> Senior Manager KPMG 1987 - 1998
> VP Finance TelePost 1998 - 2000
> CFO Antrim Design 2000 - 2001> CFO Antrim Design 2000 2001



Werner Consulting Group

Revenue Recognition Services Include:g

> Pre-Contract Negotiations and Deal Structuring
> Post-Contract Review, Analysis and Accounting, y g
> Best Practices Implementation
> VSOE Studies and Analysis
> Customized Training Classes
> Revenue Recognition Technical Research and Whitepapers
> Revenue Recognition Policy Implementation and 

Improvement
> Peak Demand Contract Review> Peak Demand Contract Review
> Revenue Management Outsourcing
> Audit Assistance
> Revenue Management Software Implementation> Revenue Management Software Implementation
> EITF 08-1 Implementations



Revenue Recognition Classg

Revenue Recognition Webcast
Tuesday November 13 Part One 

9  12 30  PDT9 am – 12:30 pm PDT
Thursday November 15 Part Two

9 am – 12:30 pm PDT9 am 12:30 pm PDT
CPE Credit
Pay per attendancey p
Registration and details soon



Revenue Recognition Classg

Revenue Recognition
Agenda Day One
> G l P i i l  f R  R iti> General Principles of Revenue Recognition
> Multiple Element Arrangements 
> VSOE> VSOE
> Software Revenue Recognition
> Services and Contract Accountingg



Revenue Recognition Classg

Revenue Recognition
Agenda Day Two
> R i  G l P i i l> Review - General Principles
> Services Contract Accounting
> Relative Selling Price Method (EITF 08-1)> Relative Selling Price Method (EITF 08 1)
> Cloud Computing (Saas)
> FASB IASB Revenue Projectj
> Other Rev Rec Issues



Cloud Computing (SaaS) Outline

> Introduction
> Cloud Computing (SaaS) Business Model
> Cloud Computing (SaaS) Accounting

 Wh  S S i  S ft When SaaS is Software
 When SaaS is Service

> Set Up Fees and Related Costs> Set Up Fees and Related Costs
> Consulting and Training Services
> Fees based on Usageg
> Cloud Computing (SaaS) and Software MEA
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SaaS Business Model

History of Software as a Service 

Application Service Provider (ASP)

Software as a Service (SaaS)

Cloud Computing
The HOT new business model
Recurring Revenue Model
Use instead of owned / installed 
softwaresoftware
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SaaS Business Model

Cloud Services - SaaS

Applications

Platforms

Infrastructure

Other Services
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SaaS Business Model

Cl d C i  (S S) Cloud Computing (SaaS) 
Evolution of the Internet
Service vs ownershipService vs ownership
SalesForce.com 

Industry Leader Industry Leader 
Made SaaS Acceptable
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SaaS Business Model

S ft    S i  S SSoftware as a Service – SaaS
Customer Advantages

Easy to implement – ready to go  standard set-upEasy to implement ready to go, standard set up
Low upfront cost 
Cost over time – pay as you go
V d  k  it i  l  i t l IT tVendor keeps it running – lower internal IT costs
Less administration of licenses – how many to buy
Automatic updates 
Easy access over the internet – browser interface
Network based rather than PC based
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SaaS Business Model

Software as a Service – SaaSSoftware as a Service SaaS

Vendor Advantagesg
Easier Sale – Lower Upfront Cost of Ownership
Predictable Ratable Revenue 
Easy To Upgrade and Change Features
Customers Locked in to Usage – hard to change 
to another Vendorto another Vendor
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SaaS Business Model

Software as a Service SaaSSoftware as a Service – SaaS
Customer Disadvantages

Mission Critical Resource in Control of VendorMission Critical Resource in Control of Vendor
Data in Control of Vendor – Privacy Concerns
Uptime dependent on Vendor and Internetp p

Vendor Disadvantages
No One Time Large Sales Revenue 
Must have customer service focus
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Cloud Computing (SaaS) 
AccountingAccounting
Accounting for Cloud Computing and SaaS Services

Revenue Recognition Changed 
ASU 2009-13ASU 2009 13
Relative Selling Price Method

Changes to what is a separate element
Changes to allocation of revenue to elements
Required in 2011Required in 2011
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Cloud Computing (SaaS) 
AccountingAccounting
Is it Software or Service?

Software
Take possession – on customer server or right to Take possession on customer server or right to 

take possession from vendor without 
significant costs 

Right and Ability to use without vendorRight and Ability to use without vendor
Perpetual and Term right of use
License Fees and Support Fees
Upgrades – part of maintenance or upgrade fees
Data at customer  
Contract may not be clearContract may not be clear
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Cloud Computing (SaaS) 
AccountingAccounting
Is it Software or Service?

Service
Hosted by Vendory
Monthly or Usage Fees
Data on Vendor Server
D t  T iti   C i  Ri ht  t E d f UData Transition or Conversion Rights at End of Use
Right to Use only
Significant additional cost to take possessionSignificant additional cost to take possession
Contract may not be clear
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Cloud Computing (SaaS)  
AccountingAccounting
Four Principles of Revenue Recognition

 Persuasive Evidence of an arrangement exists

 Delivery has occurred

 The fee is fixed and determinable

 Collectability is probable

 Not ABC - CDEF
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Accounting for Elements of an 
ArrangementArrangement

R  R iti  StRevenue Recognition Steps

1 – Separation into elements1 Separation into elements

2 – Allocation of revenue to 
elementselements

3 – Recognition of revenueg
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Accounting for Elements of an 
ArrangementArrangement

Elements or Obligations of an Arrangementg g

 Named in the contract

 Require distinct action of vendor

 Transaction price would vary if not included

  Lack of performance reduces price / penalty
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Accounting for Elements of an 
ArrangementArrangement

Separation of the Elements
 Individual elements are independent

• Functionally – one is not essential to the other
• Contractually – payments not linked or • Contractually – payments not linked or 

contingent
• No related refunds or rights of return

 Individual elements have stand alone value
• Sold separately by any vendor• Sold separately by any vendor
• Have resell value

If can’t be separated, treat as one unit of accounting
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Accounting for Elements of an 
ArrangementArrangement

All ti  f R  t  th  El tAllocation of Revenue to the Elements

 Software revenue recognition uses  Software revenue recognition uses 
the Residual Method

 Service revenue recognition uses EITF  Service revenue recognition uses EITF 
08-1 Relative Selling Method
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Accounting for Elements of an 
ArrangementArrangement

R id l M th d S ftResidual Method - Software

 Defer the full value of undelivered  Defer the full value of undelivered 
elements using Vendor Specific 
Objective Evidence (VSOE)

 Allocate the remaining value or 
residual to the delivered elements
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Accounting for Elements of an 
ArrangementArrangement

R l ti S lli P i M th d (S S)Relative Selling Price Method (SaaS)

Allocate to each element based each element Allocate to each element based each element 
percentage of total (relative value)

Value is based on VSOE TPE or ESP Value is based on VSOE, TPE or ESP

 Defer revenue for undelivered elements

 Recognize revenue for delivered elements
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Accounting for Elements of a Cloud 
Computing (SaaS) ArrangementComputing (SaaS) Arrangement

SaaS – Multiple Element SaaS Multiple Element 
Arrangements 

Subscription Fees
S t  F  Set-up Fees 
Implementation
Data Migration / ContentData Migration / Content
Consulting
Business Process
Training
Project Management
Usage FeesUsage Fees
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Accounting for Elements of a Cloud 
Computing (SaaS) ArrangementComputing (SaaS) Arrangement

S S M lti l  El t A tSaaS – Multiple Element Arrangements

Is there Stand-Alone Value?Is there Stand Alone Value?
Often in SaaS the elements do not 
have stand alone value

Stand-alone value includes items sold 
separately by another vendorseparately by another vendor
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Up-Front Fees

S S U F t S i  (S t U  F )SaaS – Up-Front Services (Set-Up Fees)
 If Up-front services are a necessary and 

inseparable part of obtaining the services

 If Up-front services have little or no value 
without the ongoing serviceswithout the ongoing services

 If Customer cannot buy the up-front services 
from another vendor

 No stand alone value – account for as one  No stand alone value account for as one 
element
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Set-up Fees

Currently no consensus on set-up feesCurrently no consensus on set up fees

 Some Companies and Auditors take the 
iti  th t th  i   t d l  l  f  position that there is no stand alone value for 

set up fees and treat as one unit of accounting 
over the contract period

 Some Companies and Auditors take the 
position that set up fees are an asset created position that set up fees are an asset created 
for the customer that has value after the initial 
contract period and should be allocated 
revenue and the revenue recognized over the revenue and the revenue recognized over the 
customer relationship period
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Up-Front Fees and Costs

C t  th t  i t l d di tl  l t d t  Costs that are incremental and directly related to 
up-front services should be accounted for 
either:
  Expensed as incurred, or
 Deferred and charged to expense 

proportionally over the over the same proportionally over the over the same 
period as the related revenue

The accounting is an option of the vendor and 
should be applied consistentlyshould be applied consistently
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Accounting for Elements of an 
ArrangementArrangement

U  F  R  R i d Wh  Usage Fees Revenue Recognized When 
Usage occurs

Monthly fees with usage fees
like cell phone bills
set number of minutes  overageset number of minutes, overage
no rollover to next period
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Accounting for Elements of an 
ArrangementArrangement

E l  # 1Example # 1
Vendor sells online service 
$12,000  $1,000 monthly service fee - one $12,000  $1,000 monthly service fee one 

year contract
Renewable in year two for $12,000 

$10 000  Consulting 5 days at $2 000 day $10,000  Consulting – 5 days at $2,000 day 
VSOE

$22,000  Total Transaction Fee

Does the Consulting have a separate value from 
the monthly service?the monthly service?
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Accounting for Elements of an 
ArrangementArrangement

E l  # 1 Example # 1 –
$  1,000 monthly service fee - VSOE
$10,000 Consulting $10,000 Consulting 

Defer monthly fee at VSOE
Recognize service fee $1,000 monthly
Recognize Consulting when completed 

(assuming Consulting has separate ( g g p
stand-alone value)
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Accounting for Elements of an 
ArrangementArrangement

Example # 2 Relative Selling Price  p g
Method
Vendor sells online service 
$12 000  $1 000 monthly service fee -$12,000  $1,000 monthly service fee -

one year contract
Renewable in year two for 
$12 000 $12,000 

$  8,000 Consulting - $2,000 day 
VSOE discounted

$20,000  Total Transaction Fee

Acco nt fo  based on elati e al eAccount for based on relative value
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Accounting for Elements of an 
ArrangementArrangement

E l  # 2 R l ti  S lli  P i   M th dExample # 2 – Relative Selling Price  Method

$12,000  55%  Subscription VSOE/ESP Value$12,000  55%  Subscription VSOE/ESP Value
$10,000 45% Consulting – VSOE/ESP Value
$22,000 100%

$11,000  55%  Subscription Revenue
$  9 000 45% Consulting Revenue$  9,000 45% Consulting Revenue
$20,000 100% Total Revenue
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Accounting for Elements of an 
ArrangementArrangement
SaaS – Multiple Element Arrangements 
Th t i l d  S S  P d t  d S ftThat include SaaS, Products and Software

Separate and Allocate under EITF 08-1Separate and Allocate under EITF 08 1

Then Recognize based on type of element
Product
Service
SoftwareSoftware
SaaS
Etc
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SaaS and Software

> Example Facts – Software and SaaS> Example Facts Software and SaaS
> A Software Company enters into an 

arrangement with a customer to delivery 
software License A, support on License A, one 
year SaaS service B and other services. 

> Contract Elements and Pricing> Contract Elements and Pricing
$ 100,000  License A
$   20,000  Support on License A$ , pp
$   50,000  SaaS Service B
$ 30,000 Services
$ 200,000  Total Contract Price
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SaaS and Software

> Example – Software and SaaS
El t V l> Element Values
$ 130,000  License A based on ESP
$   20,000  Support on License A based on VSOE$ , pp
$   60,000  SaaS Service B based on VSOE
$   40,000 Services based on VSOE
$ 250 000  Total Element Values$ 250,000  Total Element Values

> Relative Values
$ 130,000   52% License A
$  20,000     8% Support on License A
$  60,000   24% SaaS Service B
$  40,000 16% Services$  40,000 16% Services
$ 250,000  Total Element Values
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SaaS and Software

E l  S f  d S SExample – Software and SaaS
Revenue Allocation

$ 104 000  52% License A$ 104,000  52% License A
$   16,000    8% Support on License A
$   48,000  24% SaaS Service B$   48,000  24% SaaS Service B
$   32,000 16% Services
$ 200,000  Total Contract Price
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More Examples - Software & SaaS

> Example – Software and SaaS

> Revenue Recognition - software
 $100,000  License A on delivery
 $ 20 000 S bl SO $  20,000 Support ratably over one year at VSOE
 $120,000  Total Contract Price revenue

> Revenue Recognition non software> Revenue Recognition – non-software
 $   48,000  SaaS Service B ratably over one year
 $   32,000 Services as provided on a daily basis
 $   80,000  Total non-software revenue

$200,000 Total revenue
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Cloud Computing (SaaS) Recap

> Cloud Computing (SaaS) Accounting
 When SaaS is Software
 When SaaS is Service

> M lti l  El t A t> Multiple Element Arrangements
> Set Up Fees and Related Costs
> Consulting and Training Services> Consulting and Training Services
> Fees based on Usage
> SaaS and Software MEA
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Revenue Recognition Classg

Revenue Recognition Webcast
Tuesday November 13 Part One 

9 am – 12:30 pm PDT
Th d  N b  15 P t TThursday November 15 Part Two

9 am – 12:30 pm PDT
CPE CreditCPE Credit
Pay per attendance
Registration and details soong



Revenue Recognition Classg

Revenue Recognition
Agenda Day One
> General Principles of Revenue Recognition
> M lti l  El t A t  > Multiple Element Arrangements 
> VSOE
> Software Revenue Recognition> Software Revenue Recognition
> Services and Contract Accounting



Revenue Recognition Classg

Revenue Recognition
Agenda Day Two
> Review - General Principles
> S i  C t t A ti> Services Contract Accounting
> Relative Selling Price Method (EITF 08-1)
> Cloud Computing (Saas)> Cloud Computing (Saas)
> FASB IASB Revenue Project
> Other Rev Rec Issues



Additional questions or 
comments?comments?

Please contact:

Jeffrey Werner
Email wernerj@sbcglobal.net
Werner Consulting Group
Revenue Recognition Consultant



Thanks for Joining Us Today for Thanks for Joining Us Today for 
“Revenue Recognition Accounting for Cloud 
Computing (SaaS)”Computing (SaaS)


